Instruction for Using an Integrated Watershed Tidal Prism Modeling System for Simulating Fecal Coliform

Jian Shen  
*Virginia Institute of Marine Science*

Mac Sisson  
*Virginia Institute of Marine Science*

Harry V. Wang  
*Virginia Institute of Marine Science*

Follow this and additional works at: [https://scholarworks.wm.edu/reports](https://scholarworks.wm.edu/reports)

Part of the [Marine Biology Commons](https://scholarworks.wm.edu/reports)

**Recommended Citation**

This Report is brought to you for free and open access by W&M ScholarWorks. It has been accepted for inclusion in Reports by an authorized administrator of W&M ScholarWorks. For more information, please contact [scholarworks@wm.edu](mailto:scholarworks@wm.edu).
INSTRUCTION FOR USING AN INTEGRATED WATERSHED – TIDAL PRISM MODELING SYSTEM FOR SIMULATING FECAL COLIFORM

by

Jian Shen, Mac Sisson, and Harry Wang

A Report to the

Department of Environmental Quality
Commonwealth of Virginia

Special Report No. 382
In Applied Marine Science and
Ocean Engineering

School of Marine Science/Virginia Institute of Marine Science
The College of William and Mary in Virginia
Gloucester Point, VA 23062

December 2002
INSTRUCTION FOR USING AN INTEGRATED WATERSHED - TIDAL PRISM MODELING SYSTEM FOR SIMULATING FECAL COLIFORM

by

Jian Shen, Mac Sisson, and Harry Wang

A Report to the

Department of Environmental Quality
Commonwealth of Virginia

Special Report No. 382
In Applied Marine Science and
Ocean Engineering

School of Marine Science/Virginia Institute of Marine Science
The College of William and Mary in Virginia
Gloucester Point, VA 23062

December 2002

This study is part of the project of "Integrated Modeling Approach for TMDL Development of Impaired Shellfish Waters" which was 78% funded by the Watershed Programs of the Department of Environmental Quality, Commonwealth of Virginia through Grant # 5030. The views expressed herein are those of the authors and do not necessarily reflect the views of DEQ.
# TABLE OF CONTENTS

1 INTRODUCTION ........................................................................................................... 3
  1.1 Watershed Model Description .................................................................................. 4
  Table 1-1. Modules From HSPF Converted to LSPC’s Watershed Model ..................... 6
  1.2 Tidal Prism Model Description .............................................................................. 7

2 SYSTEM INSTALLATION ................................................................................................. 8

3 INSTRUCTION FOR THE MODELING SYSTEM ......................................................... 11
  3.1 Start Model System ............................................................................................... 11
  3.2 Visualizing Modeling Domain ............................................................................ 14
  3.3 Organize GIS Layer ............................................................................................. 14
  3.4 Find A Modeling Domain .................................................................................... 15
  3.5 Start a Nonpoint Source Model ........................................................................... 16
  3.6 Obtain Model Data and Model Parameters ......................................................... 17
  3.7 Run Nonpoint Source Model .............................................................................. 18
  3.8 Review Data and Model Results ............................................................................ 20
  3.9 Start to Run Tidal Prism Model .......................................................................... 23
  3.10 Model Results Analysis .................................................................................... 26
  3.11 TMDL Studies .................................................................................................... 28
  3.12 Save Model Project ............................................................................................ 30

4 INPUT AND OUTPUT DATA STRUCTURE ............................................................... 31
  4.1 Weather data ...................................................................................................... 31
  4.2 Tidal Prism Model Input .................................................................................... 31
  4.3 Model Output ...................................................................................................... 31

5 TIDAL PRISM SEGMENTATION PROCEDURE ....................................................... 35

6 CONCLUSIONS .......................................................................................................... 41

7 REFERENCES .............................................................................................................. 42
1 INTRODUCTION

Under the project entitled “Integrated Modeling Approach for TMDL Development of Virginia’s Small Coastal Basins with Fecal Coliform Impairment” under the sponsorship of the Department of Environmental Quality, Commonwealth of Virginia, an integrated modeling system was developed for simulating a small coastal basin’s response to fecal coliform contributions under various hydrologic conditions. This new tool can be used to conduct fecal coliform modeling in both the watershed and the coastal basin. The system includes an integration of a linked watershed-tidal prism model, a geographical information system (GIS), comprehensive data storage and management capabilities, and a data analysis/post-processing routine. Hydrology and fecal coliform transport are simulated for different land use categories in the basin and then distributed to streams and embayments where fecal coliform transport is simulated. The key model components of the integrated system are the Loading Simulation Program C++ (LSPC) and the tidal prism water quality model (TPWQM). Figure 1 is a diagram of the integrated system. The core of the system is a database, which stores all model related data. GIS tools and analysis tools, as well as models, can access the database through interfaces. The time series of model output are saved to a hard drive. The modeling tools will automatically access these data sets as needed.

This report is part of the final report of the project. The report uses an example to illustrate the application of the modeling system to conduct model simulation and TMDL studies. For a detailed description of using LSPC, the reader is referred to the User’s Manual for LSPC (LSPC, 2002).
1.1 Watershed Model Description

Loading Simulation Program C++ (LSPC) is a general watershed model developed by the U.S. Environmental Protection Agency (EPA) Region 4, with the support of Tetra Tech, Inc. The LSPC system builds on the previously developed Mining Data Assessment System (MDAS). EPA Region 3 provided technical direction and guidance in the development of the precursor MDAS system (Henry et al., 2002; USEPA, 2001a). The computational algorithm is based on the previous Hydrologic Simulation Program FORTRAN (HSPF) watershed model. Continued developments are supported by both EPA Regions 3 and 4. LSPC integrates GIS, comprehensive data storage and management capabilities, a dynamic watershed model, and a data analysis/post-processing system into a convenient PC-based Windows interface. The system’s greatest strength is its ability to fulfill complex and costly data organization and water quality simulation needs for large-scale watersheds while maintaining a high level of detail. The system’s key features include:

- a customized GIS interface with no proprietary software requirements,
- storage of all geographic, modeling, and point source permit data in a Microsoft Access database,
- an efficient C++ based dynamic flow, sediments, conventional pollutants, metals, and pH model based on EPA’s peer-reviewed Hydrologic Simulation Program-FORTRAN (HSPF), and
- post-processing and analytical tools designed specifically to support TMDL development and reporting requirements.
The key to representation of the source-response linkage for TMDL development with LSPC is a dynamic watershed model. This comprehensive model is a precipitation-driven watershed model that simulates watershed hydrology and pollutant transport, as well as stream hydraulics and in-stream water quality. It is capable of dynamically simulating flow, sediments, metals, temperature, and pH, as well as other conventional pollutants for pervious and impervious lands and waterbodies of varying order. The model is essentially a re-coded C++ version of selected HSPF modules (Bicknell et al., 1996). The numerical algorithms are identical to those in HSPF. Table 1-1 lists the modules from HSPF used in the current LSPC model. The model has been applied to many watersheds to develop TMDLs including acid mine drainage TMDL (USEPA, 2001a), fecal coliform TMDL studies (USEPA, 2001b), and nutrient related TMDLs (USEPA, 2001c).

To simplify the modeling process, LSPC automatically extracts required modeling data from its underlying database for a selected area. This greatly simplifies the model setup process, which requires a large amount of data processing, from land use and soil characteristics to stream geometry and point source contributions. Upon receiving a user-selected modeling domain (sub-watersheds), a new project is created to save all physical, chemical, and point source data for that domain. The system then extracts land use, stream network and geometry, and point source data from the database. After the system identifies appropriate default parameters (which are based on soil characteristics, land use practices, or model calibration), default parameters are extracted from the database, which help to eliminate tedious, repetitive user input and uninformed model
parameter selection. LSPC then automatically links upstream contributions to the downstream segments, allowing users to model freely any selected sub-areas while maintaining a top-down approach.

Table 1-1. Modules From HSPF Converted to LSPC’s Watershed Model

<table>
<thead>
<tr>
<th>RCHRES Modules</th>
<th>HYDRAVCALC</th>
<th>Simulates hydraulic behavior and pollutant transport</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONS</td>
<td></td>
<td>Simulates conservative constituents</td>
</tr>
<tr>
<td>HTRCH</td>
<td></td>
<td>Simulates heat exchange and water temperature</td>
</tr>
<tr>
<td>SEDTRN</td>
<td></td>
<td>Simulates behavior of inorganic sediment</td>
</tr>
<tr>
<td>GQUAL</td>
<td></td>
<td>Simulates behavior of a generalized quality constituent</td>
</tr>
<tr>
<td>PHCARB</td>
<td></td>
<td>Simulates pH, carbon dioxide, total inorganic carbon, and alkalinity</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PQUAL and IQUAL Modules</th>
<th>PWATER</th>
<th>Simulates water budget for a pervious land segment</th>
</tr>
</thead>
<tbody>
<tr>
<td>IWATER</td>
<td></td>
<td>Simulates water budget for an impervious land segment</td>
</tr>
<tr>
<td>SEDMNT</td>
<td></td>
<td>Simulates production and removal of sediment</td>
</tr>
<tr>
<td>PWTGAS</td>
<td></td>
<td>Estimates water temperature and dissolved gas concentrations</td>
</tr>
<tr>
<td>IQUAL</td>
<td></td>
<td>Uses simple relationships with solids and water yield</td>
</tr>
<tr>
<td>PQUAL</td>
<td></td>
<td>Simple relationships with sediment and water yield</td>
</tr>
</tbody>
</table>

The modules identical to PQUAL and IQUAL modules in HSPF were used to simulate hydrology and fecal coliform. The accumulation rate, a specific model parameter, was used to specify fecal accumulation. Selection of these model parameters is discussed in a separate report (Shen et al., 2002).
1.2 Tidal Prism Model Description

The Tidal Prism Water Quality Model (TPWQM) is a refined tidal prism model developed by the Virginia Institute of Marine Science (VIMS) (Kuo and Neilson, 1988; Kim et al., 2001). The TPWQM was developed under the sponsorship of the Virginia Coastal Resources Management Program of 1993 (Kuo and Park, 1994). The model was subsequently applied to five of Virginia's coastal basins and it has been demonstrated that it successfully simulated the water quality conditions in all of them (Park et al., 1995; Kuo et al., 1998). The TPWQM model simulates the tidal transport in terms of the concept of tidal flushing (Ketchum, 1951). The tidal prism is the amount of water coming into and going out of a coastal basin during each tidal cycle. During flood tide, a large amount of water (i.e., the tidal prism) floods into a coastal basin. This amount of water mixes with the lower tidal water within the basin. A portion of pollutant inside the basin will be transported out of the basin during ebb tide. The implementation of the concept in numerical computation is simple and straightforward. It is not only applicable to a single-stem estuary, but also applicable to coastal basins with a high degree of branching. The input data required for TPWQM include tidal range, surface area, and depth of the water body. These data are readily available for most of the small coastal basins. The tidal prism for each modeling area can be estimated based on the volume of the basins and the tidal range in the area.

The TPWQM model was integrated into the LSPC modeling framework. To facilitate modeling activities, information about tidal prism model segmentation and its associated geometry data were incorporated into the existing LSPC database. Each
modeling area was represented by a model project and a unique area key was assigned to it. Therefore, multiple modeling areas (projects) can be stored in the database while an individual area can be extracted and modeled separately. The loading linkage between LSPC and TPWQM was achieved with the use of a linkage table, which describes the linkage between each sub-watershed and its adjacent tidal prism model cell(s). The flows and fecal coliform loads from both surface runoff and ground water from multiple sub-watersheds can be added together and fed into a tidal prism model cell. For a large sub-watershed adjacent to multiple tidal prism model cells, the flow and loads are evenly divided and fed into multiple tidal prism model cells. The modification of the tidal prism model geometry and loading linkage were integrated into the PC Windows interface, which allows the user to modify model setup easily. Once watershed simulation is completed, the daily loads of each sub-watershed including flow and fecal coliform loads will be generated. The flow and load will be fed into the tidal prism model automatically and thereby drive this model.

2 SYSTEM INSTALLATION

LSPC can be installed and operated on IBM-compatible personal computers (PCs) equipped with software, random access memory (RAM), virtual memory, and hard disk space. Because the performance (response time) under the minimum requirements option might be too slow for some users, especially when dealing with large data sets, it is preferable to use a Pentium III or IV Processor with more than 500 MB RAM. The preferred set of requirements is listed in the LSPC User’s Manual (LSPC, 2002). The
LSPC GIS interface includes basic GIS functions acting as the control center for launching watershed model scenarios. This stand-alone interface easily communicates with both shape files and the Microsoft Access database, but does not directly rely on those main programs.

To install the software, run “setup.exe” on a CD-ROM. The default system files will be installed in the “c:\MDAS” directory. For the current version, the user should use this default directory. After LSPC installation is completed, several updates are required to customize the system to the pre-constructed shellfish project for the coastal basin in Virginia:
1) From the CD-ROM, double-click the “update” folder.

2) Select “HSPC.exe”, “LSPC.exe”, and “Shellfish.lpr” files and copy these files (overwrite the existing files) to the “c:\MDAS\” folder.

3) Select “data” folder on the CD-ROM under “update” folder and copy it to the “c:\MDAS\” folder and overwrite all the previously installed data folders and files.

4) Select the “Tpmodel” folder on the CD-ROM under the “update” folder and copy it to “c:\MDAS”.

5) Double-click the model folder (under “Update” folder) and select the “weather” folder. Copy “weather” folder to “c:\MDAS\model\” (overwrite installed “weather” folder).

6) Select the “project” folder and copy it to “c:\MDAS\model”.

After the update, the following files are installed in the “c:\MDAS” folder and will be used by the shellfish project. (Note: there are some other files left in the directory which can be deleted.)

**Common:**
- Dll files and system required files

**Data:**
- Data directory with all the GIS data and model database
- “Data \ Cockrell”: Cockrell GIS data
- “Data \ Poquoson”: Poquoson GIS data
- “Data \ Base.mdb”: System database including all model-required data

**Model:**
- Model\Weather: Includes model working directory and weather data
- Model\Project: Directory with sample project files
- Tpmodel: Directory with tidal prism model and related files
- LSPC.exe: LSPC model program
- HSPC: Nonpoint source model
- ShellfishVA.lpr: Shellfish project for Chesapeake Bay coastal basins.

7) After completion of file update user is required to change all data files (in c:\MDAS folders “Cockrell”, “Poquoson”, “Tpmodel”, “base.mdb”) from the “read-only” property so that each may be over-written. This is done by selecting
3. INSTRUCTION FOR THE MODELING SYSTEM

This section will provide an example of how to use modeling tool to simulate fecal coliform in a coastal basin. The instruction provides necessary steps to complete a modeling project. The instruction can be used for the users to run a pre-constructed model and conduct sensitivity runs or TMDL studies. For a complete description of the LSPC model setup and the TPWQM model setup, the reader is referred to the LSPC Users’ Manual (LSPC, 2002) and the tidal prism model (Kuo and Park, 1994). A summary of modeling procedures is illustrated in Figure 2.

3.1 Start Model System

To start the LSPC-TPWQM model system, go to the “c:\MDAS” folder and double-click the program “LSPC.exe” to activate it. A Windows interface will appear which allows the user to select the options to start the system (Figure 3). Because a project is prepared for the user, simply select “Open an existing project”, then click “OK”. After seeing an input file dialogue Window, navigate to “c:\MDAS” and select “ShellfishVA.lpr”. The project GIS interface is shown in Figure 3.

For some machines, the project will not open properly. If this happens, close “lspc.exe” selecting “Create a new project”. Then select “project > open project” and navigate to “c:\MDAS\ShellfishVA.lpr”. When the pop-up message “Do you want to close the new project” appears, click “Yes”.

these file, right-clicking to get the File Properties Window, and then un-selecting the check box corresponding to “read_only” for the selected files.
Start the model system and open an existing project

Select & visualize a modeling domain

Start nonpoint source model

Get model parameters from database

Setup model running environment

Run the model and view loading results

Process LSPC-TPWQM linking files

Run tidal prism model and compare model results

Conduct TMDL study

Figure 2. A Flowchart of Modeling Procedures.
Figure 3. An Example of Project Option and Project Interface.
3.2 Visualizing Modeling Domain

Several basic GIS tools are built into the system. The user can use these tools to get a better view of the GIS themes. Currently, built-in tools include Move, Zoom in/out, Zoom to selection, and Zoom to full extent, etc.

- Use the Pan tool to move the watershed image

- Use the Zoom in/out tool to get the desired view of Poquoson area (Figure 4)

Available GIS tools are listed as follows:

- New project
- Open project
- Save project
- Add layer
- Remove layer
- View attribute table
- Select tool
- Identify tool
- Help

3.3 Organize GIS Layer

GIS layers are shown in the left Window of the main Windows interface. To turn on/off each layer, double click the GIS layer. Figure 4 shows an example of turning on and off a tidal prism model GIS layer.
Figure 4. Example of Turning on/off a GIS Layer

3.4 Find A Modeling Domain

Each modeling area has been set in the database. To view an existing model domain,

One should follow these steps (Figure 5):

(1) click “management” pull-down menu

(2) Select “Scenario management”

(3) Select “Cockrell area”

(4) Click “Set as current” button, then click “Close” button

(5) Use “Zoom to selection” tool to zoom into the area (be sure the watershed GIS layer is highlighted).
3.5 Start a Nonpoint Source Model

To start a pre-constructed model project, go to the “Model” tool and click “Launch LSPC model”. After a project Window pops out, select “Open an existing scenario” option, then select “Cockrell” project. Click the “OK” button to launch the nonpoint source model (Figure 6).

Figure 5. Find a Modeling Domain.

Figure 6. Start a Pre-constructed Nonpoint Source Model.
3.6 Obtain Model Data and Model Parameters

All model related data and parameters are saved in the database. To run a nonpoint source model, perform the following steps to load model data and parameters (Figure 7):

(1) To load model data, go to the file from the model interface menu and select “Get From Database”.

(2) Within the Option Selection Window, the user is prompted to select the variables to be assigned. For monthly-varying parameter options, select the first three and last two options in the left column of the Window, and select the “accumulation” option in the middle column of the Window (if no radio buttons are selected, all parameters will be assigned a constant value in the LSPC model).

(3) Click OK. A message Window will pop out indicating that the point source file cannot be found, neglect the warning message and click OK in the warning Window.
Figure 7. Load Monthly Model Parameter Options.

3.7 Run Nonpoint Source Model

An example of the LSPC model interface is shown in Figure 8. The left Window provides a list of control options, which allows users to access model control and change model default parameters. Before running the model, some modeling environments need to be set:

(1) Uncheck the box in the front of the sediment (sediment will not be simulated).

(2) Check Baseline option box. When the baseline options is selected, the model results (annual loads) will be saved in a baseline table in the database which can be retrieved by inventory tools (see later data analysis section).

(3) Click “TMDL Control” in model control list and click “Watershed wide control”. Change the value in the “Landuse” field to “0” (see Figure 8).
(4) The default simulation period is from 1985 to 1997. To change the simulation period, click "Temporal Setting" under Global in the model control list of the interface and key in the desired simulation period (e.g., change 1997 to 1987).

(5) The model time series results will be saved on the hard drive under the "model/output" folder. To change the location of the time series output, click output in the model control list and change the location. Change the location to "c:\mdas\model\base"

(6) Go to file and click "Run". A message Window will pop out, showing no point source file was found or cannot write to table. Neglect the warning messages by clicking OK. For this project, no point source is discharged to the watershed. When model is running, the simulation date will appear at the bottom bar of the Window (see Figure 9).

(7) If the user wishes to stop the model, he should use the "Esc" key from keyboard.

Figure 8. Set Model Simulation Environment.
3.8 Review Data and Model Results

When model simulation is completed, the averaged annual loads will be saved in the database for analysis. The time series data will be saved on the hard drive. The interface provides an inventory tool to retrieve model data and model results.

The Data Inventory Tool provides a quick and efficient method for watershed characterization, impairment assessment, point source assessment, and model output analysis. The Inventory Tool is a collection of automated queries that process and extracts data from the database, based on the user selected sub-basins. The Data Inventory Tool organizes data reports into different categories and lists all the data reports within the same category on the Windows interface. Because all data are stored within the database and are dynamically linked, analyses of multiple tables can be conducted simultaneously. Model outputs that are important in TMDL reporting, such as annual pollutant loads from each landuse in every sub-basin, are saved in the database.
These results can be linked to other datasets to assess model performance. User-specified queries or data reports using the Inventory Tool can help streamline reporting requirements for TMDL documentation. Output generated by the inventory can also be exported in an HTML report format or loaded directly into a spreadsheet application.

To retrieve model data and results, perform the following steps:

1. Select Watershed in the left Window of GIS layers. Make sure the modeling area is selected. If modeling area is not selected, use the select tool to select the modeling area.

2. Click "Inventory" from the Window menu.

3. A message Window will pop out allowing the user to specify if feature clipping is needed. Click OK to clip the data for the first time (the clipping is not needed if user wants to use inventory again for the same modeling area).

4. An inventory Window will pop out after a while. The top Window shows the data category, and the bottom Window shows the individual data reports. Select "Simulation Result" from the top Window, then select "baseline load by watershed" and "baseline load by landuse" by holding down the shift key, then click OK. An example of the report is shown in Figure 11.
Figure 10. Example of Using Inventory Tool.

**Figure 11. Example of Data Report.**
3.9 Start to Run Tidal Prism Model

The linkage between the watershed model and the tidal prism model is implemented into the system. A linking table is integrated into the database to provide the linking information. An example of the linking table is shown in Table 2. The linking table can be edited from the HSPC Windows interface under the Tidal Prism Model -> Model linkage option of the model control list (left window of the LSPC model interface). For the current version, each tidal prism model cell can receive loads from up to 5 sub-watersheds and each main channel can link to two tributaries. A description for each field of the linking table is as follows:

- **ID:** Tidal prism model segment ID (set in the database)
- **Name:** Tidal prism model segment in a format of Nxx_x. The prefix M represents the main channel, B and T represent tributaries, and S represents storage. The tributary cell number adjacent to the cell in the main channel is separated by an underscore "_". For example, B4_3 is a third cell of a tributary and the tributary connects to the main channel cell 4. If only one tributary connects to a tidal prism model cell in the main channel, the prefix "B" should be used to denote the tributary. If two tributaries connect to the same segment in the main channel, the prefix "T" should be used to denote the secondary tributary.
- **Area:** Modeling area (project name)
- **NTP:** Total number of sub-watersheds discharging to the cell
- **WS1-WS5:** Sub-watershed ID
- **TP1-TP5:** Discharge option. "0" represents discharge directly from land and "1" represents discharge from stream(s)
• DIS: Distance of tidal prism model segment from the mouth (km)
• HV: High tide volume (1×10^6 m^3)
• P: Tidal prism (1×10^6 m^3)
• AL: Return ratio (0-1, use 0.3 for Virginia embayments)
• H: Mean depth (m)
• PTQ: Constant point source discharge (cfs)
• PTL: Constant fecal coliform loading (# counts/hour)

Table 2. An Example of Model Linkage Between Tidal Prism and Watershed Models.

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Area</th>
<th>NTP</th>
<th>WS1</th>
<th>WS2</th>
<th>WS3</th>
<th>WS4</th>
<th>WS5</th>
<th>TP1</th>
<th>TP2</th>
<th>TP3</th>
<th>TP4</th>
<th>TP5</th>
<th>DIS</th>
<th>HV</th>
<th>P</th>
<th>AL</th>
<th>H</th>
<th>PTQ</th>
<th>PTL</th>
</tr>
</thead>
<tbody>
<tr>
<td>41</td>
<td>M0_1</td>
<td>Cockrell</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.1</td>
<td>0.3</td>
<td>0.0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>M0_2</td>
<td>Cockrell</td>
<td>1</td>
<td>5804</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.5</td>
<td>1.1</td>
<td>0.9</td>
<td>0.3</td>
<td>2.8</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>M0_3</td>
<td>Cockrell</td>
<td>1</td>
<td>5804</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.9</td>
<td>1.0</td>
<td>0.8</td>
<td>0.3</td>
<td>2.8</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>M0_4</td>
<td>Cockrell</td>
<td>1</td>
<td>5804</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1.2</td>
<td>0.8</td>
<td>0.7</td>
<td>0.3</td>
<td>2.8</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>M0_5</td>
<td>Cockrell</td>
<td>1</td>
<td>5804</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1.8</td>
<td>0.7</td>
<td>0.6</td>
<td>0.3</td>
<td>2.5</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>M0_6</td>
<td>Cockrell</td>
<td>1</td>
<td>5803</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2.5</td>
<td>0.6</td>
<td>0.6</td>
<td>0.3</td>
<td>2.3</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>M0_7</td>
<td>Cockrell</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3.4</td>
<td>0.7</td>
<td>0.3</td>
<td>0.3</td>
<td>1.3</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>M0_8</td>
<td>Cockrell</td>
<td>1</td>
<td>5801</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>4.5</td>
<td>0.5</td>
<td>0.2</td>
<td>0.3</td>
<td>1.3</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>M0_9</td>
<td>Cockrell</td>
<td>1</td>
<td>5801</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>5.7</td>
<td>0.8</td>
<td>0.0</td>
<td>0.3</td>
<td>1.3</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>B4_1</td>
<td>Cockrell</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.3</td>
<td>0.0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>B4_2</td>
<td>Cockrell</td>
<td>1</td>
<td>5804</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.5</td>
<td>0.1</td>
<td>0.0</td>
<td>0.3</td>
<td>1.0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>B7_1</td>
<td>Cockrell</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.1</td>
<td>0.3</td>
<td>0.0</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>B7_2</td>
<td>Cockrell</td>
<td>1</td>
<td>5803</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0.4</td>
<td>0.5</td>
<td>0.0</td>
<td>0.3</td>
<td>1.2</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 12. Nonpoint source processing Window.
After the nonpoint source model simulation is completed, the user can start to run the tidal prism model. The current system shares the same decay constant used by the watershed model. To change the decay constant, go to the Water Quality Constituents option from the LSPC Windows. Then go to land-based Pollutant Contributions > General Settings. The decay constant in the first row is shared by the tidal prism model. This constant can be changed by the user. The first step is to process loads for the tidal prism model. To process loading time series for tidal prism model, go to File -> Process nonpoint source from HSPC model interface. The system will read all the time series files from the hard drive location specified in the output control of the LSPC interface and generate loading time series data for the tidal prism model. Next, a DOS Window will pop out and show that nonpoint source data has been processed successfully. The user can hit the Enter key to complete the data process (see Figure 13).

After loading data have been processed successfully, the user can run the tidal prism model by going to File->Run TP model. A DOS Window will appear showing that
the tidal prism model is running and where the results will be saved. Once the model is
completed successfully, enter “Enter Key” to complete the process (Figure 14).

3.10 Model Results Analysis

LSPC provides a simple tool to visualize model time series data. The users can
use this tool to compare model results against observation data. All the observation data
have been installed into the database for the projects. To use the tool, go to the LSPC
GIS interface, and highlight the “Observation” GIS layer in the left panel of the Window.
Use the select tool to select one or multiple observation stations, then click the
“Analysis” from the LSPC GIS interface. A dialogue Window will appear, at which time
one can select all the stations in the “Choose Station Ids” Window, then click OK (see
Figure 14).
Figure 14. Select Observation Data for Analysis.

Figure 15. Plot Model/Data Time Series.
After a graphics Window appears, click the square in the front of the data in the left Window of the interface, then double-click the square of the label (e.g. FC(MPN), FECAL(MPN)). The user can use the Zoom in/out tool to zoom into the graphics. To turn off the plot, double-click the label square again (Figure 15). To load the model time series, use "load model data tool", then navigate to the location of time series, and load the data. The tidal prism model time series are saved on the hard drive specified by the user in the outfile location (for this example, the files are located at "c:\MDAS\model\base folder"). Two time series data can be loaded which are "mainser.out" and "tribser.out" for model output in main channel and tributaries. The watershed model output is named by the watershed ID and is suffixed with the extension "out". For example "5803.out" is the output of subwatershed 5803. Time series of watershed model output includes surface flow, inter-flow, groundwater, fecal coliform loads contributed from land, flow from stream, and fecal coliform concentration in the stream. For better plotting results, the users can later load these time series data into spreadsheet software.

3.11 TMDL Studies

The modeling system consists of a TMDL study module and allows the user to conduct a TMDL study or sensitivity runs. To conduct a TMDL study, follow these steps:

1. Click TMDL control option -> Landuse wide control to activate the TMDL option in the model control category list
2. Set “land use” field to “2”
(3) Click TMDL control option ->distributed controls. Key in the percent reduction for the watershed and land uses where reduced loads are required (Figure 16).

(4) If the user wants to save the time series in a new location, click Output in the model control category list and set the new file directory. Set output location to “c:\mdas\model\TMDL”.

(5) Click Global Settings ->Simulation option in the model control category list and uncheck the baseline option. This option allows the user to save the model annual load to a TMDL table in the database that can be used for comparison.

(6) Run the watershed model again by going to File -> Run. Neglect the warning message Window by clicking OK.

(7) Process tidal prism model loading data by going to File ->Process nonpoint sources.

(8) Run the tidal prism model again by going to File -> Run TP model

After the simulation, the user can load the time series again by using the data analysis

Figure 16. TMDL Study Control Window.
tool to examine the model results. The percent reduction on land can be reviewed by using the inventory tool. Go to Inventory, select “Simulation results” in report category, then select “Change of loads after reduction”. An example of the TMDL report is shown in Figure 17.

**Figure 17. Example of TMDL Report.**

### 3.12 Save Model Project

Once the model simulation is completed, the user can save the project to a text file for future reference. To save the project, go to File -> Save. Provide the name of the project (e.g., projectA.inp). It is suggested to use extension “inp” for the project. The output file is a text file that can be loaded and edited by any text editing software.
The user can load a saved version of the project by using the File -> open option to run the previously saved project without loading it from the database. To exit LSPC, go to “Project > Close Project, and then click Yes to exit the LSPC program.

4 INPUT AND OUTPUT DATA STRUCTURE

4.1 Weather data

The hourly precipitation and evapotranspiration data are needed to drive the watershed model. The format of the weather data is listed in Table 3. The first 26 lines are used to describe the data. Data fields 2-6 specify time (year, month, day, hour, and minute). Fields 7 and 8 are precipitation and evapotranspiration. The current model does not use the remaining fields. However, dummy data are needed to fill these fields.

4.2 Tidal Prism Model Input

The tidal prism model information is saved in a table “TPMCELL” in the database. To prepare tidal prism model data, the model domain needs to be segmented in a specified way (Kuo and Park, 1994) [An excerpt from their report is included in Section 5]. The data format to construct the TPMCELL table is the same as the data listed in Table 2.

4.3 Model Output

Three types of tidal prism model output are output for analysis, which are tidal average time series, 30-month geometric mean, and 30-month 90th percentile. The file name for these files are “mainser.out” and “tribser.out”, “mainstd.out” and “tribstd.out”, and “mainstd9.out” and “tribstd9.out” for output in the main channel and tributaries,
respectively. The time series output file can be loaded into the system postprocessor for analysis (see analysis tool). The format of time series output is shown in Table 4. The number under the Label (line 11) is cell ID which correspond to the field in the data column. The first field is not used. The 2nd to 5th fields represent time (year, month, day, and hour). The 6th field is not used. Starting with the 7th field are fecal coliform concentration for each model cells (# counts/100mL). The time series output of geometric mean and 90th percentile is shown in Table 5. The first line shows the tidal prism model cell number. The first field is date. The second field is hour and other fields are fecal coliform concentration (counts/100mL).
Table 3. An Example of Weather Input Data.

<table>
<thead>
<tr>
<th>MIDW HSPF FILE FOR DRIVING SEPARATE PLOT PROGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDW Time interval: 60 mins Last mont</td>
</tr>
<tr>
<td>MIDW No. of curves plotted: Point-valued: 0</td>
</tr>
<tr>
<td>MIDW Label flag: 0 Pivl: 1</td>
</tr>
<tr>
<td>MIDW Plot title: MIDWAY</td>
</tr>
<tr>
<td>MIDW Y-axis label: CMS</td>
</tr>
<tr>
<td>MIDW Scale info: Ymin: 0.0000 T</td>
</tr>
<tr>
<td>MIDW Ymax: 1500.0</td>
</tr>
<tr>
<td>MIDW Time: 20.000 intervals/i</td>
</tr>
<tr>
<td>MIDW Data for each curve (Point-valued first, th</td>
</tr>
<tr>
<td>MIDW Label</td>
</tr>
<tr>
<td>MIDW LINTYP INTEQ</td>
</tr>
<tr>
<td>MIDW PREC 0 4</td>
</tr>
<tr>
<td>MIDW PEVT 0 4</td>
</tr>
<tr>
<td>MIDW ATEM 0 4</td>
</tr>
<tr>
<td>MIDW WIND 0 4</td>
</tr>
<tr>
<td>MIDW SOLR 0 4</td>
</tr>
<tr>
<td>MIDW EVAP 0 4</td>
</tr>
<tr>
<td>MIDW DEWP 0 4</td>
</tr>
<tr>
<td>MIDW CLOU 0 4</td>
</tr>
<tr>
<td>MIDW Time series (pt-valued, then mean-valued):</td>
</tr>
<tr>
<td>MIDW Date/time</td>
</tr>
<tr>
<td>MIDW Values</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 2 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 3 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 4 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 5 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 6 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 7 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 8 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>MIDW BAYD 1984 1 1 9 0 0.00000 0.0021 8.8000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
</tbody>
</table>

33
Table 4. An example of the Tidal Prism Model Output File.

<table>
<thead>
<tr>
<th>CC main channel output</th>
<th>CC Labe</th>
<th>CC Date/time</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC</td>
<td>CC</td>
<td>CC</td>
</tr>
<tr>
<td>2 (MPN)</td>
<td></td>
<td>0 1985 1 1 12 0 0.1099E-02 0.2328E-02 0.1676E-02 0.2303E-02 0.2407E-02 0.9319E-03 0.7106E-02 0.6969E-02</td>
</tr>
<tr>
<td>3 (MPN)</td>
<td></td>
<td>0 1985 1 1 23 0 0.2137E-02 0.6756E-02 0.8905E-01 0.3913E-01 0.1837E-01 0.2858E-01 0.2985E-01 0.1620E-01</td>
</tr>
<tr>
<td>4 (MPN)</td>
<td></td>
<td>0 1985 1 1 12 0 0.3858E-02 0.4186E-01 0.1967E+00 0.9519E-01 0.6491E-01 0.1393E+00 0.6669E-01 0.2935E+01</td>
</tr>
<tr>
<td>5 (MPN)</td>
<td></td>
<td>0 1985 1 1 23 0 0.1691E-01 0.9438E-01 0.3069E+00 0.1667E+00 0.1315E+00 0.2301E+00 0.1138E+00 0.4741E-01</td>
</tr>
<tr>
<td>6 (MPN)</td>
<td></td>
<td>0 1985 1 2 12 0 0.3954E-01 0.1559E+00 0.4122E+00 0.2484E+00 0.2380E+00 0.3346E+00 0.1939E+00 0.9445E-01</td>
</tr>
<tr>
<td>7 (MPN)</td>
<td></td>
<td>0 1985 1 2 23 0 0.6585E-01 0.2163E+00 0.5103E+00 0.3417E+00 0.3329E+00 0.4455E+00 0.2729E+00 0.1443E+00</td>
</tr>
<tr>
<td>8 (MPN)</td>
<td></td>
<td>0 1985 1 3 12 0 0.9417E-01 0.2776E+00 0.6065E+00 0.4348E+00 0.4148E+00 0.5485E+00 0.3693E+00 0.2159E+00</td>
</tr>
<tr>
<td>9 (MPN)</td>
<td></td>
<td>0 1985 1 3 23 0 0.1213E-01 0.3346E+00 0.6948E+00 0.5173E+00 0.5003E+00 0.6495E+00 0.4574E+00 0.2866E+00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 1985 1 4 12 0 0.1455E+00 0.3848E+00 0.7717E+00 0.5269E+00 0.5690E+00 0.7393E+00 0.5188E+00 0.3357E+00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 1985 1 4 23 0 0.1679E+00 0.4309E+00 0.8399E+00 0.6589E+00 0.6407E+00 0.8171E+00 0.5800E+00 0.3843E+00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 1985 1 5 12 0 0.1879E+00 0.4708E+00 0.8982E+00 0.7195E+00 0.7058E+00 0.8876E+00 0.6303E+00 0.4237E+00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 1985 1 5 23 0 0.2059E+00 0.5066E+00 0.9498E+00 0.7750E+00 0.7655E+00 0.9502E+00 0.6798E+00 0.4628E+00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 1985 1 6 12 0 0.2215E+00 0.5374E+00 0.9948E+00 0.8243E+00 0.8186E+00 0.1007E+01 0.7221E+00 0.4963E+00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 1985 1 6 23 0 0.2355E+00 0.5650E+00 0.1035E+01 0.8686E+00 0.8667E+00 0.1057E+01 0.7631E+00 0.5293E+00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 1985 1 7 12 0 0.2477E+00 0.5889E+00 0.1069E+01 0.9077E+00 0.9092E+00 0.1103E+01 0.7989E+00 0.5585E+00</td>
</tr>
</tbody>
</table>
Table 5. An Example of the Geometric Mean Output Time Series File.

<table>
<thead>
<tr>
<th>Date</th>
<th>Hor</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>7/1/1987</td>
<td>23</td>
<td>0.1378E+01</td>
<td>0.1760E+01</td>
<td>0.2647E+01</td>
<td>0.2893E+01</td>
<td>0.3224E+01</td>
<td>0.3292E+01</td>
<td>0.3528E+01</td>
<td>0.3222E+01</td>
</tr>
<tr>
<td>7/2/1987</td>
<td>23</td>
<td>0.1383E+01</td>
<td>0.1767E+01</td>
<td>0.2669E+01</td>
<td>0.2909E+01</td>
<td>0.3343E+01</td>
<td>0.3952E+01</td>
<td>0.3549E+01</td>
<td>0.3241E+01</td>
</tr>
<tr>
<td>7/3/1987</td>
<td>23</td>
<td>0.1388E+01</td>
<td>0.1775E+01</td>
<td>0.2673E+01</td>
<td>0.2924E+01</td>
<td>0.3361E+01</td>
<td>0.3975E+01</td>
<td>0.3569E+01</td>
<td>0.3260E+01</td>
</tr>
<tr>
<td>7/4/1987</td>
<td>23</td>
<td>0.1393E+01</td>
<td>0.1783E+01</td>
<td>0.2686E+01</td>
<td>0.2939E+01</td>
<td>0.3379E+01</td>
<td>0.3997E+01</td>
<td>0.3589E+01</td>
<td>0.3278E+01</td>
</tr>
<tr>
<td>7/5/1987</td>
<td>23</td>
<td>0.1398E+01</td>
<td>0.1790E+01</td>
<td>0.2698E+01</td>
<td>0.2953E+01</td>
<td>0.3397E+01</td>
<td>0.4019E+01</td>
<td>0.3609E+01</td>
<td>0.3296E+01</td>
</tr>
<tr>
<td>7/6/1987</td>
<td>23</td>
<td>0.1402E+01</td>
<td>0.1797E+01</td>
<td>0.2710E+01</td>
<td>0.2967E+01</td>
<td>0.3414E+01</td>
<td>0.4040E+01</td>
<td>0.3628E+01</td>
<td>0.3314E+01</td>
</tr>
<tr>
<td>7/7/1987</td>
<td>23</td>
<td>0.1406E+01</td>
<td>0.1804E+01</td>
<td>0.2721E+01</td>
<td>0.2981E+01</td>
<td>0.3430E+01</td>
<td>0.4060E+01</td>
<td>0.3646E+01</td>
<td>0.3331E+01</td>
</tr>
<tr>
<td>7/8/1987</td>
<td>23</td>
<td>0.1410E+01</td>
<td>0.1810E+01</td>
<td>0.2732E+01</td>
<td>0.2994E+01</td>
<td>0.3446E+01</td>
<td>0.4079E+01</td>
<td>0.3664E+01</td>
<td>0.3347E+01</td>
</tr>
<tr>
<td>7/9/1987</td>
<td>23</td>
<td>0.1414E+01</td>
<td>0.1816E+01</td>
<td>0.2742E+01</td>
<td>0.3006E+01</td>
<td>0.3461E+01</td>
<td>0.4097E+01</td>
<td>0.3681E+01</td>
<td>0.3363E+01</td>
</tr>
<tr>
<td>7/10/1987</td>
<td>23</td>
<td>0.1417E+01</td>
<td>0.1822E+01</td>
<td>0.2752E+01</td>
<td>0.3018E+01</td>
<td>0.3475E+01</td>
<td>0.4114E+01</td>
<td>0.3698E+01</td>
<td>0.3379E+01</td>
</tr>
<tr>
<td>7/11/1987</td>
<td>23</td>
<td>0.1420E+01</td>
<td>0.1827E+01</td>
<td>0.2761E+01</td>
<td>0.3029E+01</td>
<td>0.3489E+01</td>
<td>0.4131E+01</td>
<td>0.3714E+01</td>
<td>0.3394E+01</td>
</tr>
<tr>
<td>7/12/1987</td>
<td>23</td>
<td>0.1423E+01</td>
<td>0.1833E+01</td>
<td>0.2769E+01</td>
<td>0.3039E+01</td>
<td>0.3502E+01</td>
<td>0.4146E+01</td>
<td>0.3729E+01</td>
<td>0.3408E+01</td>
</tr>
<tr>
<td>7/13/1987</td>
<td>23</td>
<td>0.1425E+01</td>
<td>0.1837E+01</td>
<td>0.2777E+01</td>
<td>0.3049E+01</td>
<td>0.3514E+01</td>
<td>0.4160E+01</td>
<td>0.3744E+01</td>
<td>0.3422E+01</td>
</tr>
<tr>
<td>7/14/1987</td>
<td>23</td>
<td>0.1428E+01</td>
<td>0.1842E+01</td>
<td>0.2784E+01</td>
<td>0.3058E+01</td>
<td>0.3525E+01</td>
<td>0.4174E+01</td>
<td>0.3757E+01</td>
<td>0.3435E+01</td>
</tr>
<tr>
<td>7/15/1987</td>
<td>23</td>
<td>0.1430E+01</td>
<td>0.1846E+01</td>
<td>0.2791E+01</td>
<td>0.3067E+01</td>
<td>0.3536E+01</td>
<td>0.4186E+01</td>
<td>0.3770E+01</td>
<td>0.3448E+01</td>
</tr>
<tr>
<td>7/16/1987</td>
<td>23</td>
<td>0.1432E+01</td>
<td>0.1849E+01</td>
<td>0.2797E+01</td>
<td>0.3075E+01</td>
<td>0.3546E+01</td>
<td>0.4198E+01</td>
<td>0.3783E+01</td>
<td>0.3460E+01</td>
</tr>
<tr>
<td>7/17/1987</td>
<td>23</td>
<td>0.1433E+01</td>
<td>0.1853E+01</td>
<td>0.2803E+01</td>
<td>0.3082E+01</td>
<td>0.3555E+01</td>
<td>0.4209E+01</td>
<td>0.3794E+01</td>
<td>0.3471E+01</td>
</tr>
</tbody>
</table>

5 TIDAL PRISM SEGMENTATION PROCEDURE

[Note: This section has been reproduced in part from Kuo and Park (1994)].

Segmentation starts at the mouth of the creek (Kuo and Neilson, 1988). The water body outside the mouth is denoted as the 1st segment (Figure 18). The adjacent segment within the creek is indexed as the 2nd segment. The 1st transect is across the mouth and the 2nd transect is chosen such that a water particle will move from the 1st to the 2nd transect over flood tide. Therefore, the tidal prism, or inter-tidal volume, upriver of the 2nd transect must be large enough to accommodate the low tide volume in the 2nd segment plus the volume of freshwater inflow upriver of the 2nd transect over flood tide, i.e.,

\[ P_2 = V_2 + R_2 \]

or

\[ V_2 = P_2 - R_2 \]

(1)

\[ P_2 = \text{tidal prism, or inter-tidal volume, upriver of the 2nd transect including those in branches} \]
\( V_2 = \text{low tide volume of the } 2\text{nd segment} \)

\( R_2 = \text{volume of freshwater entering the creek upriver of the } 2\text{nd transect during a half tidal cycle. If } R_2 \text{ varies in time, the median value of } R_2 \text{ should be used.} \)

In general, a water particle at the \((i-1)\text{th transect at the beginning of flood tide should move to the } i\text{th transect at the end of flood tide. Thus:} \)

\[
P_i = V_i + R_i \tag{2}
\]

\[
V_i = P_i - R_i = (P_{i+1} + p_{i+1}) - (R_{i+1} + r_{i+1}) \tag{3}
\]

\[
= V_{i+1} + p_{i+1} - r_{i+1} \tag{4}
\]

\[
= V_{H_{i+1}} - r_{i+1} \tag{5}
\]

\( P_i = \text{tidal prism upriver of the } i\text{th transect including those in branches} \)

\( V_i = \text{low tide volume of the } i\text{th segment} \)

\( R_i = \text{volume of freshwater entering the creek upriver of the } i\text{th transect during a half tidal cycle} \)

\( p_i = \text{local tidal prism of the } i\text{th segment} \)

\( r_i = \text{volume of lateral inflow into the } i\text{th segment during a half tidal cycle including point and nonpoint source discharges} \)

\( V_{H_i} = \text{high tide volume of the } i\text{th segment} = V_{i+1} + p_{i+1}. \)

From the definitions:

\[
P_i = \sum_{n=i+1}^{I+1} P_i \quad \text{and} \quad R_i = \sum_{n=i+1}^{I+1} r_i \tag{6}
\]

Equation 5 states that the low tide volume of a segment is equal to the high tide volume of its immediate upriver segment less the lateral freshwater inflow into that segment.
It may be seen from Eq. 4 that $V_i$ approaches zero as $P_i$ decreases toward the head of tide. Therefore, the infinite number of segments will result unless a cut-off criterion is defined. One guideline is to continue segmentation until a segment length becomes smaller than its width. As this condition is reached, the remainder of the tidal creek is combined into one single segment, the $I^{th}$ segment (see Figure 18). The prism upriver of the $I^{th}$ transect is equal to the freshwater discharge of the $I^{th}$ transect, i.e., $P_i = R_i$. The length of the $I^{th}$ segment will be larger than the local tidal excursion and complete mixing cannot be achieved within this segment. The model-simulated concentration at this segment still represents the average value of the segment, however. Landward of the $I^{th}$ transect, the creek behaves more like a fluvial stream than a tidal creek and flushing is due solely to the freshwater discharge. Segmentation in the freshwater section is arbitrary and governed only by the spatial resolution desired and the segment length-to-width ratio.

For branches, segmentation also starts at the branch-main channel junction. As the $1^{st}$ segment in the main channel is outside the creek mouth, the $1^{st}$ segment in the $k^{th}$ branch entering the $i^{th}$ main channel segment, denoted as the $(k,1)^{th}$ segment, is located in the main channel. That is, the $(k,1)^{th}$ segment shares the same segment as the $i^{th}$ segment. Segmentation in branches proceeds upriver in the same manner as the main channel.

Figure 19 shows, for a hypothetical creek, the accumulated low tide volume, $V_A(x)$, and the difference between the tidal prism and the river inflow upriver of a point, $[P(x) - R(x)]$, plotted as a function of $x$, the distance from the mouth. $V_A(x)$ is defined as the accumulated low tide volume of the main channel from the mouth to any distance $x$. $P(x)$ is defined as the inter-tidal volume upriver of a transect located at $x$. $R(x)$ is
defined as the freshwater input, summed over a half tidal cycle, which enters the creek upriver of a transect located at x.

The volume, \( P(0) = P_1 \), is the inter-tidal volume of the entire creek. \( R(0) = R_1 \) is the total freshwater input to the creek including river flow, and point and nonpoint source discharges. The volume \( V_1 \) is the dummy volume located outside the creek mouth and the first volume within the creek is defined as \( V_2 \). To satisfy the assumption of complete mixing within each segment, segment lengths must be less than or equal to the local tidal excursions. Therefore, the low tide volume of the first segment within the creek (\( V_2 \)) should equal the inter-tidal volume (\( P_2 \)) minus the river flow (\( R_2 \)) upriver of its upriver boundary transect (Eq. 1). This point, where \( V_2 = P_2 - R_2 \), can be determined graphically or by interpolation of a table of values of \( V_A(x) \) and \( [P(x) - R(x)] \). Segmentation continues upriver in this manner until the cut-off guideline is approached.

In a segment where the branch comes in (e.g., the 4th segment in Figure 19), the inter-tidal volume of the branch, \( P_T \), should be included in determining the segment volume. \( P(x) \) is defined to include the tidal prism of the branch and \( R(x) \) is defined to include the freshwater input from the branch. The value \( V_A(x) \) remains as the accumulated low tide volume along the main channel. For segments with branches, therefore, the curve \( [P(x) - R(x)] \) needs to be extrapolated from the branch junction to the upriver transect of the segment. Each branch may be segmented in the same way as that of the main channel.
Figure 18. Segmentation of a Water Body
Figure 19. Graphical Method of Segmentation of a Water Body
6 CONCLUSIONS

This document provides instruction on the use of a newly developed watershed-tidal prism modeling system to simulate fecal coliform in the coastal basins. The example is based on a reconstructed project. The instruction provides basic steps needed to complete a model simulation. For more options of the system and model set up of the watershed model, the users are referred to the Users’ Manual included in the Appendix. For tidal prism model setup, particularly segmentation, the user is referred to the VIMS report by Kuo and Park (1994).
7. REFERENCES


National Climatic Data Center. 2000. Data Documentation for Integrated Surface


USEPA. 2001b. Total Maximum Daily Load for Pathogens, Flint Creek Watershed

USEPA. 2001c. Total Maximum Daily Load (TMDL) For Metals, Pathogens and Turbidity In the Hurricane Creek Watershed.


INSTRUCTION FOR USING AN INTEGRATED WATERSHED – TIDAL PRISM MODELING SYSTEM FOR SIMULATING FECAL COLIFORM

by

Jian Shen, Mac Sisson, and Harry Wang

A Report to the

Department of Environmental Quality
Commonwealth of Virginia

Special Report No. 382
In Applied Marine Science and Ocean Engineering

School of Marine Science/Virginia Institute of Marine Science
The College of William and Mary in Virginia
Gloucester Point, VA 23062

December 2002
INSTRUCTION FOR USING AN INTEGRATED WATERSHED - TIDAL PRISM MODELING SYSTEM FOR SIMULATING FECAL COLIFORM

by

Jian Shen, Mac Sisson, and Harry Wang

A Report to the

Department of Environmental Quality
Commonwealth of Virginia

Special Report No. 382
In Applied Marine Science and
Ocean Engineering

School of Marine Science/Virginia Institute of Marine Science
The College of William and Mary in Virginia
Gloucester Point, VA 23062

December 2002

This study is part of the project of “Integrated Modeling Approach for TMDL Development of Impaired Shellfish Waters” which was 78% funded by the Watershed Programs of the Department of Environmental Quality, Commonwealth of Virginia through Grant # 5030. The views expressed herein are those of the authors and do not necessarily reflect the views of DEQ.
TABLE OF CONTENTS

1 INTRODUCTION .......................................................................................................................... 3
   1.1 Watershed Model Description ............................................................................................... 4
   Table 1-1. Modules From HSPF Converted to LSPC’s Watershed Model ..................................... 6
   1.2 Tidal Prism Model Description ............................................................................................ 7
2 SYSTEM INSTALLATION ................................................................................................................. 8
3 INSTRUCTION FOR THE MODELING SYSTEM ......................................................................... 11
   3.1 Start Model System .................................................................................................................. 11
   3.2 Visualizing Modeling Domain ................................................................................................ 14
   3.3 Organize GIS Layer ................................................................................................................ 14
   3.4 Find A Modeling Domain ............... .................................................................................... 15
   3.5 Start a Nonpoint Source Model ............................................................................................ 16
   3.6 Obtain Model Data and Model Parameters .......................................................................... 17
   3.7 Run Nonpoint Source Model ............................................................................................... 18
   3.8 Review Data and Model Results ......................................................................................... 20
   3.9 Start to Run Tidal Prism Model ............................................................................................ 23
   3.10 Model Results Analysis ....................................................................................................... 26
   3.11 TMDL Studies ..................................................................................................................... 28
   3.12 Save Model Project .............................................................................................................. 30
4 INPUT AND OUTPUT DATA STRUCTURE .................................................................................. 31
   4.1 Weather data ......................................................................................................................... 31
   4.2 Tidal Prism Model Input ....................................................................................................... 31
   4.3 Model Output ....................................................................................................................... 31
5 TIDAL PRISM SEGMENTATION PROCEDURE ............................................................................ 35
6 CONCLUSIONS ............................................................................................................................. 41
7 REFERENCES ................................................................................................................................. 42
1 INTRODUCTION

Under the project entitled “Integrated Modeling Approach for TMDL Development of Virginia’s Small Coastal Basins with Fecal Coliform Impairment” under the sponsorship of the Department of Environmental Quality, Commonwealth of Virginia, an integrated modeling system was developed for simulating a small coastal basin’s response to fecal coliform contributions under various hydrologic conditions. This new tool can be used to conduct fecal coliform modeling in both the watershed and the coastal basin. The system includes an integration of a linked watershed-tidal prism model, a geographical information system (GIS), comprehensive data storage and management capabilities, and a data analysis/post-processing routine. Hydrology and fecal coliform transport are simulated for different land use categories in the basin and then distributed to streams and embayments where fecal coliform transport is simulated. The key model components of the integrated system are the Loading Simulation Program C++ (LSPC) and the tidal prism water quality model (TPWQM). Figure 1 is a diagram of the integrated system. The core of the system is a database, which stores all model related data. GIS tools and analysis tools, as well as models, can access the database through interfaces. The time series of model output are saved to a hard drive. The modeling tools will automatically access these data sets as needed.

This report is part of the final report of the project. The report uses an example to illustrate the application of the modeling system to conduct model simulation and TMDL studies. For a detailed description of using LSPC, the reader is referred to the User’s Manual for LSPC (LSPC, 2002).
1.1 Watershed Model Description

Loading Simulation Program C++ (LSPC) is a general watershed model developed by the U.S. Environmental Protection Agency (EPA) Region 4, with the support of Tetra Tech, Inc. The LSPC system builds on the previously developed Mining Data Assessment System (MDAS). EPA Region 3 provided technical direction and guidance in the development of the precursor MDAS system (Henry et al., 2002; USEPA, 2001a). The computational algorithm is based on the previous Hydrologic Simulation Program FORTRAN (HSPF) watershed model. Continued developments are supported by both EPA Regions 3 and 4. LSPC integrates GIS, comprehensive data storage and management capabilities, a dynamic watershed model, and a data analysis/post-processing system into a convenient PC-based Windows interface. The system’s greatest strength is its ability to fulfill complex and costly data organization and water quality simulation needs for large-scale watersheds while maintaining a high level of detail. The system’s key features include:

- a customized GIS interface with no proprietary software requirements,
- storage of all geographic, modeling, and point source permit data in a Microsoft Access database,
- an efficient C++ based dynamic flow, sediments, conventional pollutants, metals, and pH model based on EPA’s peer-reviewed Hydrologic Simulation Program-FORTRAN (HSPF), and
- post-processing and analytical tools designed specifically to support TMDL development and reporting requirements.
The key to representation of the source-response linkage for TMDL development with LSPC is a dynamic watershed model. This comprehensive model is a precipitation-driven watershed model that simulates watershed hydrology and pollutant transport, as well as stream hydraulics and in-stream water quality. It is capable of dynamically simulating flow, sediments, metals, temperature, and pH, as well as other conventional pollutants for pervious and impervious lands and waterbodies of varying order. The model is essentially a re-coded C++ version of selected HSPF modules (Bicknell et al., 1996). The numerical algorithms are identical to those in HSPF. Table 1-1 lists the modules from HSPF used in the current LSPC model. The model has been applied to many watersheds to develop TMDLs including acid mine drainage TMDL (USEPA, 2001a), fecal coliform TMDL studies (USEPA, 2001b), and nutrient related TMDLs (USEPA, 2001c).

To simplify the modeling process, LSPC automatically extracts required modeling data from its underlying database for a selected area. This greatly simplifies the model setup process, which requires a large amount of data processing, from land use and soil characteristics to stream geometry and point source contributions. Upon receiving a user-selected modeling domain (sub-watersheds), a new project is created to save all physical, chemical, and point source data for that domain. The system then extracts land use, stream network and geometry, and point source data from the database. After the system identifies appropriate default parameters (which are based on soil characteristics, land use practices, or model calibration), default parameters are extracted from the database, which help to eliminate tedious, repetitive user input and uninformed model
parameter selection. LSPC then automatically links upstream contributions to the downstream segments, allowing users to model freely any selected sub-areas while maintaining a top-down approach.

Table 1-1. Modules From HSPF Converted to LSPC’s Watershed Model

<table>
<thead>
<tr>
<th>RCHRES Modules</th>
<th>HYDR</th>
<th>ADCALC</th>
<th>Simulates hydraulic behavior and pollutant transport</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONS</td>
<td>Simulates conservative constituents</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HTRCH</td>
<td>Simulates heat exchange and water temperature</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SEDTRN</td>
<td>Simulates behavior of inorganic sediment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GQUAL</td>
<td>Simulates behavior of a generalized quality constituent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PHCARB</td>
<td>Simulates pH, carbon dioxide, total inorganic carbon,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>and alkalinity</td>
<td></td>
</tr>
<tr>
<td>PQUAL and IQUAL Modules</td>
<td>PWATER</td>
<td>Simulates water budget for a pervious land segment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IWATER</td>
<td>Simulates water budget for an impervious land segment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SEDMNT</td>
<td>Simulates production and removal of sediment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PWTGAS</td>
<td>Estimates water temperature and dissolved gas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>concentrations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IQUAL</td>
<td>Uses simple relationships with solids and water yield</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PQUAL</td>
<td>Simple relationships with sediment and water yield</td>
<td></td>
</tr>
</tbody>
</table>

The modules identical to PQUAL and IQUAL modules in HSPF were used to simulate hydrology and fecal coliform. The accumulation rate, a specific model parameter, was used to specify fecal accumulation. Selection of these model parameters is discussed in a separate report (Shen et al., 2002).
1.2 Tidal Prism Model Description

The Tidal Prism Water Quality Model (TPWQM) is a refined tidal prism model developed by the Virginia Institute of Marine Science (VIMS) (Kuo and Neilson, 1988; Kim et al., 2001). The TPWQM was developed under the sponsorship of the Virginia Coastal Resources Management Program of 1993 (Kuo and Park, 1994). The model was subsequently applied to five of Virginia’s coastal basins and it has been demonstrated that it successfully simulated the water quality conditions in all of them (Park et al., 1995; Kuo et al., 1998). The TPWQM model simulates the tidal transport in terms of the concept of tidal flushing (Ketchum, 1951). The tidal prism is the amount of water coming into and going out of a coastal basin during each tidal cycle. During flood tide, a large amount of water (i.e., the tidal prism) floods into a coastal basin. This amount of water mixes with the lower tidal water within the basin. A portion of pollutant inside the basin will be transported out of the basin during ebb tide. The implementation of the concept in numerical computation is simple and straightforward. It is not only applicable to a single-stem estuary, but also applicable to coastal basins with a high degree of branching. The input data required for TPWQM include tidal range, surface area, and depth of the water body. These data are readily available for most of the small coastal basins. The tidal prism for each modeling area can be estimated based on the volume of the basins and the tidal range in the area.

The TPWQM model was integrated into the LSPC modeling framework. To facilitate modeling activities, information about tidal prism model segmentation and its associated geometry data were incorporated into the existing LSPC database. Each
modeling area was represented by a model project and a unique area key was assigned to it. Therefore, multiple modeling areas (projects) can be stored in the database while an individual area can be extracted and modeled separately. The loading linkage between LSPC and TPWQM was achieved with the use of a linkage table, which describes the linkage between each sub-watershed and its adjacent tidal prism model cell(s). The flows and fecal coliform loads from both surface runoff and ground water from multiple sub-watersheds can be added together and fed into a tidal prism model cell. For a large sub-watershed adjacent to multiple tidal prism model cells, the flow and loads are evenly divided and fed into multiple tidal prism model cells. The modification of the tidal prism model geometry and loading linkage were integrated into the PC Windows interface, which allows the user to modify model setup easily. Once watershed simulation is completed, the daily loads of each sub-watershed including flow and fecal coliform loads will be generated. The flow and load will be fed into the tidal prism model automatically and thereby drive this model.

2 SYSTEM INSTALLATION

LSPC can be installed and operated on IBM-compatible personal computers (PCs) equipped with software, random access memory (RAM), virtual memory, and hard disk space. Because the performance (response time) under the minimum requirements option might be too slow for some users, especially when dealing with large data sets, it is preferable to use a Pentium III or IV Processor with more than 500 MB RAM. The preferred set of requirements is listed in the LSPC User’s Manual (LSPC, 2002). The
LSPC GIS interface includes basic GIS functions acting as the control center for launching watershed model scenarios. This stand-alone interface easily communicates with both shape files and the Microsoft Access database, but does not directly rely on those main programs.

To install the software, run “setup.exe” on a CD-ROM. The default system files will be installed in the “c:\MDAS” directory. For the current version, the user should use this default directory. After LSPC installation is completed, several updates are required to customize the system to the pre-constructed shellfish project for the coastal basin in Virginia:
1) From the CD-ROM, double-click the “update” folder.

2) Select “HSPC.exe”, “LSPC.exe”, and “Shellfish.lpr” files and copy these files (overwrite the existing files) to the “c:\MDAS\” folder.

3) Select “data” folder on the CD-ROM under “update” folder and copy it to the “c:\MDAS\” folder and overwrite all the previously installed data folders and files.

4) Select the “Tpmodel” folder on the CD-ROM under the “update” folder and copy it to “c:\MDAS\”.

5) Double-click the model folder (under “Update” folder) and select the “weather” folder. Copy “weather” folder to “c:\MDAS\model\” (overwrite installed “weather” folder).

6) Select the “project” folder and copy it to “c:\MDAS\model\”.

After the update, the following files are installed in the “c:\MDAS\” folder and will be used by the shellfish project. (Note: there are some other files left in the directory which can be deleted.)

- **Common**: Dll files and system required files

- **Data**: Data directory with all the GIS data and model database
  - “Data \Cockrell\”: Cockrell GIS data
  - “Data \Poquoson\”: Poquoson GIS data
  - “Data \Base.mdb\”: System database including all model-required data

- **Model**: Includes model working directory and weather data
  - Model\Weather: includes precipitation data “bayair_new.inp”
  - Model\Project: Directory with sample project files
  - Tpmodel: Directory with tidal prism model and related files
  - LSPC.exe: LSPC model program
  - HSPC: Nonpoint source model
  - ShellfishVA.lpr: Shellfish project for Chesapeake Bay coastal basins.

7) After completion of file update user is required to change all data files (in c:\MDAS folders “Cockrell”, “Poquoson”, “Tpmodel”, “base.mdb”) from the “read-only” property so that each may be over-written. This is done by selecting
these file, right-clicking to get the File Properties Window, and then un-selecting the check box corresponding to “read_only” for the selected files.

3 INSTRUCTION FOR THE MODELING SYSTEM

This section will provide an example of how to use modeling tool to simulate fecal coliform in a coastal basin. The instruction provides necessary steps to complete a modeling project. The instruction can be used for the users to run a pre-constructed model and conduct sensitivity runs or TMDL studies. For a complete description of the LSPC model setup and the TPWQM model setup, the reader is referred to the LSPC Users’ Manual (LSPC, 2002) and the tidal prism model (Kuo and Park, 1994). A summary of modeling procedures is illustrated in Figure 2.

3.1 Start Model System

To start the LSPC-TPWQM model system, go to the “c:\MDAS” folder and double-click the program “LSPC.exe” to activate it. A Windows interface will appear which allows the user to select the options to start the system (Figure 3). Because a project is prepared for the user, simply select “Open an existing project”, then click “OK”. After seeing an input file dialogue Window, navigate to “c:\MDAS” and select “ShellfishVA.lpr”. The project GIS interface is shown in Figure 3.

For some machines, the project will not open properly. If this happens, close “lspc.exe” selecting “Create a new project”. Then select “project > open project” and navigate to “c:\MDAS\ShellfishVA.lpr”. When the pop-up message “Do you want to close the new project” appears, click “Yes”. 
Figure 2. A Flowchart of Modeling Procedures.
Figure 3. An Example of Project Option and Project Interface.
3.2 Visualizing Modeling Domain

Several basic GIS tools are built into the system. The user can use these tools to get a better view of the GIS themes. Currently, built-in tools include Move, Zoom in/out, Zoom to selection, and Zoom to full extent, etc.

- Use the Pan tool 🌘 to move the watershed image
- Use the Zoom in/out tool 🌘 to get the desired view of Poquoson area (Figure 4)

Available GIS tools are listed as follows

<table>
<thead>
<tr>
<th>New project</th>
<th>Add point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open project</td>
<td>Delete point</td>
</tr>
<tr>
<td>Save project</td>
<td>Move point</td>
</tr>
<tr>
<td>Add layer</td>
<td>Zoom in</td>
</tr>
<tr>
<td>Remove layer</td>
<td>Zoom out</td>
</tr>
<tr>
<td>View attribute table</td>
<td>Pan</td>
</tr>
<tr>
<td>Select tool</td>
<td>Zoom to selection</td>
</tr>
<tr>
<td>Identify tool</td>
<td>Zoom to full extent</td>
</tr>
<tr>
<td>Help</td>
<td>Show/hide layer</td>
</tr>
</tbody>
</table>

3.3 Organize GIS Layer

GIS layers are shown in the left Window of the main Windows interface. To turn on/off each layer, double click the GIS layer. Figure 4 shows an example of turning on and off a tidal prism model GIS layer.
Figure 4. Example of Turning on/off a GIS Layer

3.4 Find A Modeling Domain

Each modeling area has been set in the database. To view an existing model domain,

One should follow these steps (Figure 5):

(1) click “management” pull-down menu

(2) Select “Scenario management”

(3) Select “Cockrell area”

(4) Click “Set as current” button, then click “Close” button

(5) Use “Zoom to selection” tool to zoom into the area (be sure the watershed GIS layer is highlighted).
### 3.5 Start a Nonpoint Source Model

To start a pre-constructed model project, go to the “Model” tool and click “Launch LSPC model”. After a project window pops out, select “Open an existing scenario” option, then select “Cockrell” project. Click the “OK” button to launch the nonpoint source model (Figure 6).

![Figure 5. Find a Modeling Domain.](image1)

![Figure 6. Start a Pre-constructed Nonpoint Source Model.](image2)

16
3.6 Obtain Model Data and Model Parameters

All model related data and parameters are saved in the database. To run a nonpoint source model, perform the following steps to load model data and parameters (Figure 7):

(1) To load model data, go to the file from the model interface menu and select “Get From Database”

(2) Within the Option Selection Window, the user is prompted to select the variables to be assigned. For monthly-varying parameter options, select the first three and last two options in the left column of the Window, and select the “accumulation” option in the middle column of the Window (if no radio buttons are selected, all parameters will be assigned a constant value in the LSPC model).

(3) Click OK. A message Window will pop out indicating that the point source file cannot be found, neglect the warning message and click OK in the warning Window.
3.7 Run Nonpoint Source Model

An example of the LSPC model interface is shown in Figure 8. The left Window provides a list of control options, which allows users to access model control and change model default parameters. Before running the model, some modeling environments need to be set:

1. Uncheck the box in the front of the sediment (sediment will not be simulated).
2. Check Baseline option box. When the baseline options is selected, the model results (annual loads) will be saved in a baseline table in the database which can be retrieved by inventory tools (see later data analysis section).
3. Click “TMDL Control” in model control list and click “Watershed wide control”.

Change the value in the “Landuse” field to “0” (see Figure 8).
(4) The default simulation period is from 1985 to 1997. To change the simulation period, click "Temporal Setting" under Global in the model control list of the interface and key in the desired simulation period (e.g., change 1997 to 1987).

(5) The model time series results will be saved on the hard drive under the "model/output" folder. To change the location of the time series output, click output in the model control list and change the location. Change the location to "c:\mdas\model\base"

(6) Go to file and click "Run". A message Window will pop out, showing no point source file was found or cannot write to table. Neglect the warning messages by clicking OK. For this project, no point source is discharged to the watershed. When model is running, the simulation date will appear at the bottom bar of the Window (see Figure 9).

(7) If the user wishes to stop the model, he should use the "Esc" key from keyboard.

Figure 8. Set Model Simulation Environment.
3.8 Review Data and Model Results

When model simulation is completed, the averaged annual loads will be saved in the database for analysis. The time series data will be saved on the hard drive. The interface provides an inventory tool to retrieve model data and model results.

The Data Inventory Tool provides a quick and efficient method for watershed characterization, impairment assessment, point source assessment, and model output analysis. The Inventory Tool is a collection of automated queries that process and extracts data from the database, based on the user selected sub-basins. The Data Inventory Tool organizes data reports into different categories and lists all the data reports within the same category on the Windows interface. Because all data are stored within the database and are dynamically linked, analyses of multiple tables can be conducted simultaneously. Model outputs that are important in TMDL reporting, such as annual pollutant loads from each landuse in every sub-basin, are saved in the database.
These results can be linked to other datasets to assess model performance. User-specified queries or data reports using the Inventory Tool can help streamline reporting requirements for TMDL documentation. Output generated by the inventory can also be exported in an HTML report format or loaded directly into a spreadsheet application.

To retrieve model data and results, perform the following steps:

1. Select Watershed in the left Window of GIS layers. Make sure the modeling area is selected. If modeling area is not selected, use the select tool to select the modeling area.

2. Click “Inventory” from the Window menu.

3. A message Window will pop out allowing the user to specify if feature clipping is needed. Click OK to clip the data for the first time (the clipping is not needed if user wants to use inventory again for the same modeling area).

4. An inventory Window will pop out after a while. The top Window shows the data category, and the bottom Window shows the individual data reports. Select “Simulation Result” from the top Window, then select “baseline load by watershed” and “baseline load by landuse” by holding down the shift key, then click OK. An example of the report is shown in Figure 11.
Figure 10. Example of Using Inventory Tool.

Figure 11. Example of Data Report.
3.9 Start to Run Tidal Prism Model

The linkage between the watershed model and the tidal prism model is implemented into the system. A linking table is integrated into the database to provide the linking information. A example of the linking table is shown in Table 2. The linking table can be edited from the HSPC Windows interface under the Tidal Prism Model -> Model linkage option of the model control list (left Window of the LSPC model interface). For the current version, each tidal prism model cell can receive loads from up to 5 sub-watersheds and each main channel can link to two tributaries. A description for each field of the linking table is as follows:

- **ID**: Tidal prism model segment ID (set in the database)
- **Name**: Tidal prism model segment in a format of Nxx_x. The prefix M represents the main channel, B and T represent tributaries, and S represents storage. The tributary cell number adjacent to the cell in the main channel is separated by an underscore "_". For example, B4_3 is a third cell of a tributary and the tributary connects to the main channel cell 4. If only one tributary connects to a tidal prism model cell in the main channel, the prefix "B" should be used to denote the tributary. If two tributaries connect to the same segment in the main channel, the prefix "T" should be used to denote the secondary tributary.
- **Area**: Modeling area (project name)
- **NTP**: Total number of sub-watersheds discharging to the cell
- **WS1-WS5**: Sub-watershed ID
- **TP1-TP5**: Discharge option. "0" represents discharge directly from land and "1" represents discharge from stream(s)
- DIS: Distance of tidal prism model segment from the mouth (km)
- HV: High tide volume \((1 \times 10^6 \text{ m}^3)\)
- P: Tidal prism \((1 \times 10^6 \text{ m}^3)\)
- AL: Return ratio (0-1, use 0.3 for Virginia embayments)
- H: Mean depth (m)
- PTQ: Constant point source discharge (cfs)
- PTL: Constant fecal coliform loading (# counts/hour)

Table 2. An Example of Model Linkage Between Tidal Prism and Watershed Models.

| ID | Name  | Area | NTP | WS1 | WS2 | WS3 | WS4 | WS5 | TP1 | TP2 | TP3 | TP5 | DIS | HV | P | AL | H | PTQ | PTL |
|----|-------|------|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|-----|---|---|---|---|-----|-----|
| 41 | M0_1  | Cockrell | 0  | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.0| 0.0| 1.1| 0.3| 0.0  | 0   |
| 42 | M0_2  | Cockrell | 1  | 5804 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.5 | 1.1| 0.9| 0.3| 2.8 | 0   |
| 43 | M0_3  | Cockrell | 1  | 5804 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.9 | 1.0| 0.8| 0.3| 2.8 | 0   |
| 44 | M0_4  | Cockrell | 1  | 5804 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 1.2 | 0.8| 0.7| 0.3| 2.8 | 0   |
| 45 | M0_5  | Cockrell | 1  | 5804 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.1 | 0.7| 0.6| 0.3| 2.5 | 0   |
| 46 | M0_6  | Cockrell | 1  | 5803 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.2 | 0.5| 0.6| 0.3| 2.3 | 0   |
| 47 | M0_7  | Cockrell | 0  | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.4 | 0.7| 0.3| 0.3| 1.3 | 0   |
| 48 | M0_8  | Cockrell | 1  | 5801 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.4 | 0.5| 0.2| 0.3| 1.3 | 0   |
| 49 | M0_9  | Cockrell | 1  | 5801 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.5 | 0.8| 0.0| 0.3| 1.3 | 0   |
| 50 | B4_1  | Cockrell | 0  | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.0 | 0.0| 0.0| 0.0| 0.0 | 0   |
| 51 | B4_2  | Cockrell | 1  | 5804 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.5 | 0.1| 0.0| 0.3| 1.0 | 0   |
| 52 | B7_1  | Cockrell | 0  | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.0 | 0.1| 0.3| 0.0 | 0   |
| 53 | B7_2  | Cockrell | 1  | 5803 | 0   | 0   | 0   | 0   | 0   | 0   | 0   | 0.4 | 0.5| 0.0| 0.3| 1.2 | 0   |

Figure 12. Nonpoint source processing Window.
After the nonpoint source model simulation is completed, the user can start to run the tidal prism model. The current system shares the same decay constant used by the watershed model. To change the decay constant, go to the Water Quality Constituents option from the LSPC Windows. Then go to land-based Pollutant Contributions > General Settings. The decay constant in the first row is shared by the tidal prism model. This constant can be changed by the user. The first step is to process loads for the tidal prism model. To process loading time series for tidal prism model, go to File -> Process nonpoint source from HSPC model interface. The system will read all the time series files from the hard drive location specified in the output control of the LSPC interface and generate loading time series data for the tidal prism model. Next, a DOS Window will pop out and show that nonpoint source data has been processed successfully. The user can hit the Enter key to complete the data process (see Figure 13).

After loading data have been processed successfully, the user can run the tidal prism model by going to File->Run TP model. A DOS Window will appear showing that
the tidal prism model is running and where the results will be saved. Once the model is completed successfully, enter "Enter Key" to complete the process (Figure 14).

3.10 Model Results Analysis

LSPC provides a simple tool to visualize model time series data. The users can use this tool to compare model results against observation data. All the observation data have been installed into the database for the projects. To use the tool, go to the LSPC GIS interface, and highlight the "Observation" GIS layer in the left panel of the Window. Use the select tool to select one or multiple observation stations, then click the "Analysis" from the LSPC GIS interface. A dialogue Window will appear, at which time one can select all the stations in the "Choose Station IDs" Window, then click OK (see Figure 14).
Figure 14. Select Observation Data for Analysis.

Figure 15. Plot Model/Data Time Series.
After a graphics Window appears, click the square in the front of the data in the left Window of the interface, then double-click the square of the label (e.g. FC(MPN), FECAL(MPN)). The user can use the Zoom in/out tool to zoom into the graphics. To turn off the plot, double-click the label square again (Figure 15). To load the model time series, use “load model data tool”, then navigate to the location of time series, and load the data. The tidal prism model time series are saved on the hard drive specified by the user in the outfile location (for this example, the files are located at “c:\MDAS\model\base folder”). Two time series data can be loaded which are “mainser.out” and “tribser.out” for model output in main channel and tributaries. The watershed model output is named by the watershed ID and is suffixed with the extension “out”. For example “5803.out” is the output of subwatershed 5803. Time series of watershed model output includes surface flow, inter-flow, groundwater, fecal coliform loads contributed from land, flow from stream, and fecal coliform concentration in the stream. For better plotting results, the users can later load these time series data into spreadsheet software.

3.11 TMDL Studies

The modeling system consists of a TMDL study module and allows the user to conduct a TMDL study or sensitivity runs. To conduct a TMDL study, follow these steps:

1. Click TMDL control option -> Landuse wide control to activate the TMDL option in the model control category list
2. Set “land use” field to “2”
(3) Click TMDL control option ->distributed controls. Key in the percent reduction for the watershed and land uses where reduced loads are required (Figure 16).

(4) If the user wants to save the time series in a new location, click Output in the model control category list and set the new file directory. Set output location to "c:\mdas\model\TMDL".

(5) Click Global Settings ->Simulation option in the model control category list and uncheck the baseline option. This option allows the user to save the model annual load to a TMDL table in the database that can be used for comparison.

(6) Run the watershed model again by going to File -> Run. Neglect the warning message Window by clicking OK.

(7) Process tidal prism model loading data by going to File -> Process nonpoint sources.

(8) Run the tidal prism model again by going to File -> Run TP model

After the simulation, the user can load the time series again by using the data analysis

Figure 16. TMDL Study Control Window.
tool to examine the model results. The percent reduction on land can be reviewed by using the inventory tool. Go to Inventory, select “Simulation results” in report category, then select “Change of loads after reduction”. An example of the TMDL report is shown in Figure 17.

![Data Inventory — Change of Loads After Reduction](image)

**Figure 17. Example of TMDL Report.**

### 3.12 Save Model Project

Once the model simulation is completed, the user can save the project to a text file for future reference. To save the project, go to File -> Save. Provide the name of the project. (e.g., projectA.inp). It is suggested to use extension “inp” for the project. The output file is a text file that can be loaded and edited by any text editing software.
The user can load a saved version of the project by using the File -> open option to run the previously saved project without loading it from the database. To exit LSPC, go to “Project > Close Project, and then click Yes to exit the LSPC program.

4 INPUT AND OUTPUT DATA STRUCTURE

4.1 Weather data

The hourly precipitation and evapotranspiration data are needed to drive the watershed model. The format of the weather data is listed in Table 3. The first 26 lines are used to describe the data. Data fields 2-6 specify time (year, month, day, hour, and minute). Fields 7 and 8 are precipitation and evapotranspiration. The current model does not use the remaining fields. However, dummy data are needed to fill these fields.

4.2 Tidal Prism Model Input

The tidal prism model information is saved in a table “TPMCELL” in the database. To prepare tidal prism model data, the model domain needs to be segmented in a specified way (Kuo and Park, 1994) [An excerpt from their report is included in Section 5]. The data format to construct the TPMCELL table is the same as the data listed in Table 2.

4.3 Model Output

Three types of tidal prism model output are output for analysis, which are tidal average time series, 30-month geometric mean, and 30-month 90th percentile. The file name for these files are “mainser.out” and “tribser.out”, “mainstd.out” and “tribstd.out”, and “mainstd9.out” and “tribstd9.out” for output in the main channel and tributaries,
respectively. The time series output file can be loaded into the system postprocessor for analysis (see analysis tool). The format of time series output is shown in Table 4. The number under the Label (line 11) is cell ID which correspond to the field in the data column. The first field is not used. The 2nd to 5th fields represent time (year, month, day, and hour). The 6th field is not used. Starting with the 7th field are fecal coliform concentration for each model cells (# counts/100mL). The time series output of geometric mean and 90th percentile is shown in Table 5. The first line shows the tidal prism model cell number. The first field is date. The second field is hour and other fields are fecal coliform concentration (counts/100mL).
Table 3. An Example of Weather Input Data.

<table>
<thead>
<tr>
<th>MIDW</th>
<th>HSPF FILE FOR DRIVING SEPARATE PLOT PROGRAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDW</td>
<td>Time interval: 60 mins</td>
</tr>
<tr>
<td>MIDW</td>
<td>Last month</td>
</tr>
<tr>
<td>MIDW</td>
<td>No. of curves plotted: Point-valued: 0</td>
</tr>
<tr>
<td>MIDW</td>
<td>Label flag: 0</td>
</tr>
<tr>
<td>MIDW</td>
<td>Pvl: 1</td>
</tr>
<tr>
<td>MIDW</td>
<td>Plot title: MIDWAY</td>
</tr>
<tr>
<td>MIDW</td>
<td>Y-axis label: CMS</td>
</tr>
<tr>
<td>MIDW</td>
<td>Scale info: Ymin: 0.0000</td>
</tr>
<tr>
<td>MIDW</td>
<td>Ymax: 1500.0</td>
</tr>
<tr>
<td>MIDW</td>
<td>Time: 20,000 intervals/ist</td>
</tr>
<tr>
<td>MIDW</td>
<td>Data for each curve (Point-valued first, th)</td>
</tr>
<tr>
<td>MIDW</td>
<td>Label LINTYP INTEQ</td>
</tr>
<tr>
<td>MIDW</td>
<td>PREC 0 4</td>
</tr>
<tr>
<td>MIDW</td>
<td>PEVT 0 4</td>
</tr>
<tr>
<td>MIDW</td>
<td>ATEM 0 4</td>
</tr>
<tr>
<td>MIDW</td>
<td>WIND 0 4</td>
</tr>
<tr>
<td>MIDW</td>
<td>SOLR 0 4</td>
</tr>
<tr>
<td>MIDW</td>
<td>EVAP 0 4</td>
</tr>
<tr>
<td>MIDW</td>
<td>DEWP 0 4</td>
</tr>
<tr>
<td>MIDW</td>
<td>CLOU 0 4</td>
</tr>
<tr>
<td>MIDW</td>
<td>Time series (pt-valued, then mean-valued):</td>
</tr>
<tr>
<td>MIDW</td>
<td>Date/time Values</td>
</tr>
<tr>
<td>MIDW</td>
<td></td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 1 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 2 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 3 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 4 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 5 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 6 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 7 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 8 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
<tr>
<td>BAYD</td>
<td>1984 1 1 9 0 0.0000 0.0021 8.000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000</td>
</tr>
</tbody>
</table>

33
Table 4. An example of the Tidal Prism Model Output File.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Channel 1</th>
<th>Channel 2</th>
<th>Channel 3</th>
<th>Channel 4</th>
<th>Channel 5</th>
<th>Channel 6</th>
<th>Channel 7</th>
<th>Channel 8</th>
<th>Channel 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>1985</td>
<td>1</td>
<td>0.1099E-02</td>
<td>0.2328E-02</td>
<td>0.1676E-02</td>
<td>0.2303E-02</td>
<td>0.2407E-02</td>
<td>0.9319E-03</td>
<td>0.7106E-02</td>
<td>0.6969E-02</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>1</td>
<td>0.2137E-02</td>
<td>0.6756E-02</td>
<td>0.8905E-01</td>
<td>0.3913E-01</td>
<td>0.1837E-01</td>
<td>0.5883E-01</td>
<td>0.2985E-01</td>
<td>0.1620E-01</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>1</td>
<td>0.3858E-02</td>
<td>0.4186E-01</td>
<td>0.1967E+00</td>
<td>0.9519E-01</td>
<td>0.6491E-01</td>
<td>0.1393E+00</td>
<td>0.6669E-01</td>
<td>0.2935E-01</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>1</td>
<td>0.1691E-01</td>
<td>0.9438E-01</td>
<td>0.3069E+00</td>
<td>0.1667E+00</td>
<td>0.1315E+00</td>
<td>0.2301E+00</td>
<td>0.1138E+00</td>
<td>0.4741E-01</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>2</td>
<td>0.3954E-01</td>
<td>0.1559E+00</td>
<td>0.4122E+00</td>
<td>0.2484E+00</td>
<td>0.2380E+00</td>
<td>0.3346E+00</td>
<td>0.1939E+00</td>
<td>0.9445E-01</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>2</td>
<td>0.6585E-01</td>
<td>0.2163E+00</td>
<td>0.5103E+00</td>
<td>0.3417E+00</td>
<td>0.3329E+00</td>
<td>0.4455E+00</td>
<td>0.2729E+00</td>
<td>0.1443E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>3</td>
<td>0.9417E-01</td>
<td>0.2776E+00</td>
<td>0.6065E+00</td>
<td>0.4348E+00</td>
<td>0.4148E+00</td>
<td>0.5485E+00</td>
<td>0.3693E+00</td>
<td>0.2159E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>3</td>
<td>0.1213E+00</td>
<td>0.3346E+00</td>
<td>0.6948E+00</td>
<td>0.5173E+00</td>
<td>0.5003E+00</td>
<td>0.6495E+00</td>
<td>0.4574E+00</td>
<td>0.2866E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>4</td>
<td>0.1455E+00</td>
<td>0.3848E+00</td>
<td>0.7717E+00</td>
<td>0.5926E+00</td>
<td>0.5650E+00</td>
<td>0.7393E+00</td>
<td>0.5188E+00</td>
<td>0.3357E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>4</td>
<td>0.1679E+00</td>
<td>0.4309E+00</td>
<td>0.8399E+00</td>
<td>0.6589E+00</td>
<td>0.6407E+00</td>
<td>0.8171E+00</td>
<td>0.5800E+00</td>
<td>0.3843E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>5</td>
<td>0.1879E+00</td>
<td>0.4708E+00</td>
<td>0.8982E+00</td>
<td>0.7195E+00</td>
<td>0.7097E+00</td>
<td>0.8876E+00</td>
<td>0.6302E+00</td>
<td>0.4237E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>5</td>
<td>0.2059E+00</td>
<td>0.5066E+00</td>
<td>0.9498E+00</td>
<td>0.7750E+00</td>
<td>0.7655E+00</td>
<td>0.9502E+00</td>
<td>0.6798E+00</td>
<td>0.4628E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>6</td>
<td>0.2215E+00</td>
<td>0.5374E+00</td>
<td>0.994E+00</td>
<td>0.8242E+00</td>
<td>0.8186E+00</td>
<td>0.1007E+01</td>
<td>0.7221E+00</td>
<td>0.4963E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>6</td>
<td>0.2355E+00</td>
<td>0.5650E+00</td>
<td>0.1035E+01</td>
<td>0.8686E+00</td>
<td>0.8667E+00</td>
<td>0.1057E+01</td>
<td>0.7631E+00</td>
<td>0.5293E+00</td>
<td></td>
</tr>
<tr>
<td>1985</td>
<td>7</td>
<td>0.2477E+00</td>
<td>0.5889E+00</td>
<td>0.1069E+01</td>
<td>0.9077E+00</td>
<td>0.9092E+00</td>
<td>0.1103E+01</td>
<td>0.7989E+00</td>
<td>0.5585E+00</td>
<td></td>
</tr>
</tbody>
</table>
Table 5. An Example of the Geometric Mean Output Time Series File.

<table>
<thead>
<tr>
<th>Date</th>
<th>Hor</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>7/1/1987</td>
<td>23</td>
<td>0.1378E+01</td>
<td>0.1760E+01</td>
<td>0.2647E+01</td>
<td>0.2893E+01</td>
<td>0.3324E+01</td>
<td>0.3929E+01</td>
<td>0.3528E+01</td>
<td>0.3222E+01</td>
</tr>
<tr>
<td>7/2/1987</td>
<td>23</td>
<td>0.1383E+01</td>
<td>0.1767E+01</td>
<td>0.2660E+01</td>
<td>0.2909E+01</td>
<td>0.3343E+01</td>
<td>0.3952E+01</td>
<td>0.3549E+01</td>
<td>0.3241E+01</td>
</tr>
<tr>
<td>7/3/1987</td>
<td>23</td>
<td>0.1388E+01</td>
<td>0.1775E+01</td>
<td>0.2673E+01</td>
<td>0.2924E+01</td>
<td>0.3361E+01</td>
<td>0.3975E+01</td>
<td>0.3569E+01</td>
<td>0.3260E+01</td>
</tr>
<tr>
<td>7/4/1987</td>
<td>23</td>
<td>0.1393E+01</td>
<td>0.1783E+01</td>
<td>0.2686E+01</td>
<td>0.2939E+01</td>
<td>0.3379E+01</td>
<td>0.3997E+01</td>
<td>0.3597E+01</td>
<td>0.3278E+01</td>
</tr>
<tr>
<td>7/5/1987</td>
<td>23</td>
<td>0.1398E+01</td>
<td>0.1790E+01</td>
<td>0.2698E+01</td>
<td>0.2953E+01</td>
<td>0.3397E+01</td>
<td>0.4019E+01</td>
<td>0.3609E+01</td>
<td>0.3296E+01</td>
</tr>
<tr>
<td>7/6/1987</td>
<td>23</td>
<td>0.1402E+01</td>
<td>0.1797E+01</td>
<td>0.2710E+01</td>
<td>0.2967E+01</td>
<td>0.3414E+01</td>
<td>0.4040E+01</td>
<td>0.3628E+01</td>
<td>0.3314E+01</td>
</tr>
<tr>
<td>7/7/1987</td>
<td>23</td>
<td>0.1406E+01</td>
<td>0.1804E+01</td>
<td>0.2721E+01</td>
<td>0.2981E+01</td>
<td>0.3430E+01</td>
<td>0.4060E+01</td>
<td>0.3646E+01</td>
<td>0.3331E+01</td>
</tr>
<tr>
<td>7/8/1987</td>
<td>23</td>
<td>0.1410E+01</td>
<td>0.1810E+01</td>
<td>0.2732E+01</td>
<td>0.2994E+01</td>
<td>0.3446E+01</td>
<td>0.4079E+01</td>
<td>0.3664E+01</td>
<td>0.3347E+01</td>
</tr>
<tr>
<td>7/9/1987</td>
<td>23</td>
<td>0.1414E+01</td>
<td>0.1816E+01</td>
<td>0.2742E+01</td>
<td>0.3006E+01</td>
<td>0.3461E+01</td>
<td>0.4097E+01</td>
<td>0.3681E+01</td>
<td>0.3363E+01</td>
</tr>
<tr>
<td>7/10/1987</td>
<td>23</td>
<td>0.1417E+01</td>
<td>0.1822E+01</td>
<td>0.2752E+01</td>
<td>0.3018E+01</td>
<td>0.3475E+01</td>
<td>0.4114E+01</td>
<td>0.3698E+01</td>
<td>0.3379E+01</td>
</tr>
<tr>
<td>7/11/1987</td>
<td>23</td>
<td>0.1420E+01</td>
<td>0.1827E+01</td>
<td>0.2761E+01</td>
<td>0.3029E+01</td>
<td>0.3489E+01</td>
<td>0.4131E+01</td>
<td>0.3714E+01</td>
<td>0.3394E+01</td>
</tr>
<tr>
<td>7/12/1987</td>
<td>23</td>
<td>0.1423E+01</td>
<td>0.1833E+01</td>
<td>0.2769E+01</td>
<td>0.3039E+01</td>
<td>0.3502E+01</td>
<td>0.4146E+01</td>
<td>0.3729E+01</td>
<td>0.3408E+01</td>
</tr>
<tr>
<td>7/13/1987</td>
<td>23</td>
<td>0.1425E+01</td>
<td>0.1837E+01</td>
<td>0.2777E+01</td>
<td>0.3049E+01</td>
<td>0.3514E+01</td>
<td>0.4160E+01</td>
<td>0.3744E+01</td>
<td>0.3422E+01</td>
</tr>
<tr>
<td>7/14/1987</td>
<td>23</td>
<td>0.1428E+01</td>
<td>0.1842E+01</td>
<td>0.2784E+01</td>
<td>0.3058E+01</td>
<td>0.3525E+01</td>
<td>0.4174E+01</td>
<td>0.3757E+01</td>
<td>0.3435E+01</td>
</tr>
<tr>
<td>7/15/1987</td>
<td>23</td>
<td>0.1430E+01</td>
<td>0.1846E+01</td>
<td>0.2791E+01</td>
<td>0.3067E+01</td>
<td>0.3536E+01</td>
<td>0.4186E+01</td>
<td>0.3770E+01</td>
<td>0.3448E+01</td>
</tr>
<tr>
<td>7/16/1987</td>
<td>23</td>
<td>0.1432E+01</td>
<td>0.1849E+01</td>
<td>0.2797E+01</td>
<td>0.3075E+01</td>
<td>0.3546E+01</td>
<td>0.4198E+01</td>
<td>0.3783E+01</td>
<td>0.3460E+01</td>
</tr>
<tr>
<td>7/17/1987</td>
<td>23</td>
<td>0.1433E+01</td>
<td>0.1853E+01</td>
<td>0.2803E+01</td>
<td>0.3082E+01</td>
<td>0.3555E+01</td>
<td>0.4209E+01</td>
<td>0.3794E+01</td>
<td>0.3471E+01</td>
</tr>
</tbody>
</table>

5 TIDAL PRISM SEGMENTATION PROCEDURE

[Note: This section has been reproduced in part from Kuo and Park (1994)].

Segmentation starts at the mouth of the creek (Kuo and Neilson, 1988). The water body outside the mouth is denoted as the 1st segment (Figure 18). The adjacent segment within the creek is indexed as the 2nd segment. The 1st transect is across the mouth and the 2nd transect is chosen such that a water particle will move from the 1st to the 2nd transect over flood tide. Therefore, the tidal prism, or inter-tidal volume, upriver of the 2nd transect must be large enough to accommodate the low tide volume in the 2nd segment plus the volume of freshwater inflow upriver of the 2nd transect over flood tide, i.e.,

\[ P_2 = V_2 + R_2 \] or \[ V_2 = P_2 - R_2 \] (1)

\( P_2 \) = tidal prism, or inter-tidal volume, upriver of the 2nd transect including those in branches
\( V_2 \) = low tide volume of the 2\(^{nd} \) segment

\( R_2 \) = volume of freshwater entering the creek upriver of the 2\(^{nd} \) transect during a half tidal cycle. If \( R_2 \) varies in time, the median value of \( R_2 \) should be used.

In general, a water particle at the \((i-1)\)th transect at the beginning of flood tide should move to the \(i\)th transect at the end of flood tide. Thus:

\[
P_i = V_i + R_i
\]

(2)

\[
V_i = P_i - R_i = (P_{i+1} + p_{i+1}) - (R_{i+1} + r_{i+1})
\]

(3)

\[
= V_{i+1} + p_{i+1} - r_{i+1}
\]

(4)

\[
= V_{hi+1} - r_{i+1}
\]

(5)

\( P_i \) = tidal prism upriver of the \(i\)th transect including those in branches

\( V_i \) = low tide volume of the \(i\)th segment

\( R_i \) = volume of freshwater entering the creek upriver of the \(i\)th transect during a half tidal cycle

\( p_i \) = local tidal prism of the \(i\)th segment

\( r_i \) = volume of lateral inflow into the \(i\)th segment during a half tidal cycle including point and nonpoint source discharges

\( V_{hi} \) = high tide volume of the \(i\)th segment = \( V_{i+1} + p_{i+1} \).

From the definitions:

\[
P_i = \sum_{n=i+1}^{i+1} P_i \quad \text{and} \quad R_i = \sum_{n=i+1}^{i+1} r_i
\]

(6)

Equation 5 states that the low tide volume of a segment is equal to the high tide volume of its immediate upriver segment less the lateral freshwater inflow into that segment.
It may be seen from Eq. 4 that $V_i$ approaches zero as $P_i$ decreases toward the head of tide. Therefore, the infinite number of segments will result unless a cut-off criterion is defined. One guideline is to continue segmentation until a segment length becomes smaller than its width. As this condition is reached, the remainder of the tidal creek is combined into one single segment, the $i^{th}$ segment (see Figure 18). The prism upriver of the $i^{th}$ transect is equal to the freshwater discharge of the $i^{th}$ transect, i.e., $P_i = R_i$. The length of the $i^{th}$ segment will be larger than the local tidal excursion and complete mixing cannot be achieved within this segment. The model-simulated concentration at this segment still represents the average value of the segment, however. Landward of the $i^{th}$ transect, the creek behaves more like a fluvial stream than a tidal creek and flushing is due solely to the freshwater discharge. Segmentation in the freshwater section is arbitrary and governed only by the spatial resolution desired and the segment length-to-width ratio.

For branches, segmentation also starts at the branch-main channel junction. As the $1^{st}$ segment in the main channel is outside the creek mouth, the $1^{st}$ segment in the $k^{th}$ branch entering the $i^{th}$ main channel segment, denoted as the $(k,1)^{th}$ segment, is located in the main channel. That is, the $(k,1)^{th}$ segment shares the same segment as the $i^{th}$ segment. Segmentation in branches proceeds upriver in the same manner as the main channel.

Figure 19 shows, for a hypothetical creek, the accumulated low tide volume, $V_A(x)$, and the difference between the tidal prism and the river inflow upriver of a point, $[P(x) - R(x)]$, plotted as a function of $x$, the distance from the mouth. $V_A(x)$ is defined as the accumulated low tide volume of the main channel from the mouth to any distance $x$. $P(x)$ is defined as the inter-tidal volume upriver of a transect located at $x$. $R(x)$ is
defined as the freshwater input, summed over a half tidal cycle, which enters the creek upriver of a transect located at x.

The volume, \( P(0) = P_1 \), is the inter-tidal volume of the entire creek. \( R(0) = R_1 \) is the total freshwater input to the creek including river flow, and point and nonpoint source discharges. The volume \( V_1 \) is the dummy volume located outside the creek mouth and the first volume within the creek is defined as \( V_2 \). To satisfy the assumption of complete mixing within each segment, segment lengths must be less than or equal to the local tidal excursions. Therefore, the low tide volume of the first segment within the creek (\( V_2 \)) should equal the inter-tidal volume (\( P_2 \)) minus the river flow (\( R_2 \)) upriver of its upriver boundary transect (Eq. 1). This point, where \( V_2 = P_2 - R_2 \), can be determined graphically or by interpolation of a table of values of \( V_A(x) \) and \([P(x) - R(x)]\). Segmentation continues upriver in this manner until the cut-off guideline is approached.

In a segment where the branch comes in (e.g., the 4th segment in Figure 19), the inter-tidal volume of the branch, \( P_T \), should be included in determining the segment volume. \( P(x) \) is defined to include the tidal prism of the branch and \( R(x) \) is defined to include the freshwater input from the branch. The value \( V_A(x) \) remains as the accumulated low tide volume along the main channel. For segments with branches, therefore, the curve \([P(x) - R(x)]\) needs to be extrapolated from the branch junction to the upriver transect of the segment. Each branch may be segmented in the same way as that of the main channel.
Figure 18. Segmentation of a Water Body
Figure 19. Graphical Method of Segmentation of a Water Body
6 CONCLUSIONS

This document provides instruction on the use of a newly developed watershed-tidal prism modeling system to simulate fecal coliform in the coastal basins. The example is based on a reconstructed project. The instruction provides basic steps needed to complete a model simulation. For more options of the system and model set up of the watershed model, the users are referred to the Users' Manual included in the Appendix. For tidal prism model setup, particularly segmentation, the user is referred to the VIMS report by Kuo and Park (1994).
7. REFERENCES


National Climatic Data Center. 2000. Data Documentation for Integrated Surface


USEPA. 2001b. Total Maximum Daily Load for Pathogens, Flint Creek Watershed

USEPA. 2001c. Total Maximum Daily Load (TMDL) For Metals, Pathogens and Turbidity In the Hurricane Creek Watershed.

VDEQ. 2001. Fecal Coliform TMDL (Total Maximum Daily Load) Development for Holmans Creek, Virginia
